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1. Introduction to the CloneSelector Users Guide 
CloneSelector is a tool developed to help plant breeder carry out field trials. In version 1.1 the 

functionality is focused on the process of carrying out a trial to test a list of germplasm, and it may help 

you in the following task: 

1) Elaborate list of germplasm to test 

2) Design of field trial with one or more experiments  

3) Generation of a field book for each experiment 

4) Register metadata for each experiment 

5) Data collection in field and post harvest for each entry 

6) Enter collected data into electronic field book 

7) Calculation of derived variables (yield/ha etc) 

8) Statistical analysis of trial 

9) Elaboration of consolidated result table for each trial 

The CloneSelector is based on the Maize Fieldbook developed by CIMMYT, and this tool has many 

additional functions especially related to seed management. For clonally propagated crops this 

functionality is not adequate and it has been eliminated in CloneSelector, however, for seed based crops 

it might be better to use the original Maize Fieldbook, which is available at CIMMYT.  The current 

version of CloneSelector is targeted at sweetpotato, but it can be used for any crop as long as the trial 

template is adapted to include the relevant traits. 

The CloneSelector for Potato is based the Procedures for standard evaluation trials of advanced 

potato clones. An International Cooperators’ Guide, CIP (2007) (ICG), and as such it is a practical tool 

that aims to help the potato breeders put these standardized methods into practice, and by doing that 

it aims to improve the efficiency and effectiveness of the breeding effort. The Procedures have been 

incorporated into the user’s guide in order to facilitate the learning and adoption of both tools. 

Furthermore, the process of operationalizing the procedures in a specific tool has lead to some minor 

adjustments on how the information is structured or presented, and the User Guide presents these 

changed data formats. Also in order to keep CloneSelector relatively simple to use, it only includes the 

most common traits used for potato breeding, and not the full range covered in the ICG. 

For the installation of CloneSelector see Chapter 5. 
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2. How to use CloneSelector in a potato trial 
This section describes how to use CloneSelector as an integrated tool in the process of carrying out a 

potato trial in accordance with the general protocol described in the CIP manual for procedures for 

standard evaluation for advanced potato clones. The information is organized in the sequence of the 

general steps for carrying out a trial, and the user should consult the relevant section as the trial is 

carried out.  

When CloneSelector is first installed the templates are in a generic format. In order to work more 

efficiently and not have to tweak for example the fieldbooks every time, the user may modify the 

templates to be more suitable for the local conditions, however, for the first trials it is recommend to 

use the standard templates in order to gain a better understanding before the templates are modified. 

The process for modifying the templates is described in a subsequent section. 

Some general advice on using CloneSelector for trials 

1. Save your data frequently as errors may happen and you may lose the work you have done 

2. Backup you data files frequently. 

3. For the first trials follow the instructions in this guide as closely as possible. Once you know 

the general working of CloneSelector you can start adapting it to your more specific needs. 

4. Experiment with CloneSelector before you using it in a real trial. You can for example try to do 

all the steps in the guide with a trial from last season.   

5. The fieldbook in CloneSelector as you will see below is made up of several sheets and these are 

linked in different manners. If you want to make changes outside what is described in the 

following steps only do so on a copy, not in the original. Changes may prevent CloneSelector 

from working, and you will probably not be able undo the changes.  

6. Remember, in the worst case your data is in Excel, and if CloneSelector fails to do exactly what 

you need, you can always do your calculations or analysis as a normal Excel sheet or exporting 

the data to a statistical package of your choice.  

If you invest a little time on learning CloneSelector this will make you a more efficient breeder, and you 

will spend more time drawing the right conclusions from your trial, and less time on repetitive steps. 
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2.1 How to start CloneSelector? 
 

CloneSelector is an ‘Add-in’ to Microsoft Excel, and to use it you must open it as any other Excel file1. 

After opening, Excel 2007 will have an additional menu in the Add-in section and in Excel 2003 the menu 

is added directly in the primary menu bar of the application. 

 

Figure 1 CloneSelector Add-in menu in Excel 2007 

When you click on the CloneSelector menu it opens up. Initially, only the List of 

Germplasm, Trial and Options menus are available. The rest of the menus will 

become available once you open or create a List of Germplasm or a Trial. If you 

cannot access a menu it is because you are not in the right type of workbook, or 

you are not on the correct sheet.  

Warning: CloneSelector use the name of the sheet to activate the 

relevant menus. Do not change the names of the Fieldbook, Results 

and Master sheets as the menus will not work properly. 

CloneSelector is based on Excel, and apart from the tools in the system, you also 

have access to all the normal Excel functions. You must however, be careful not 

to change the structure of the CloneSelector sheets as these will most likely not 

work correctly afterwards. The safest solution is to insert a new sheet or use the 

space below the tables generated by CloneSelector. Similarly, it is preferable to hide columns or rows, 

rather than deleting them as this may cause problems. 

If you have changed the structure of a worksheet and this is not working properly or if you have data in 

a normal Excel sheet that you want to analyze in CloneSelector the best solution is to create a new List 

of Germplasm or Trial sheet in CloneSelector and copy the information over using Paste Special and 

only paste Values. Doing this will not change your data and will maintain all the functionality and 

formatting in CloneSelector.   

  

                                                           
1
 On Windows XP it is possible to add the CloneSelector to the XLSTART folder and it will start automatically when 

Excel is initiated, however, the security of Windows Vista and Windows 7 does not allow this approach.  

Figure 2 CloneSelector 
menus 
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2.2 Elaboration of list of germplasm to test 
A trial in CloneSelector is conceptually a method for evaluating a list of germplasm with regard to certain 

traits. To some extent all the tools in CloneSelector are focused on manipulating the List of Germplasm 

and the first step in a trial is to prepare a List of Germplasm:  

CloneSelector -> List of Germplasm -> New 

 In the dialog that opens enter or select the 

Season. The recommendation is to indicate 

Year either as e.g. 2010 or 10 and A, B, C for 

the Season. The Season you enter will be the 

name of the folder where the file is stored.  You must also 

enter a List ID, which will become the name of the file. It is 

recommend that you use a code such as LG for List of Germplam, and AT (Advanced Trial) for type of 

trial, and then the season e.g LGAT10B.  

Warning: Do not use spaces in the 

name, as this will cause problems 

when trying to generate the field book. 

Click OK once you have entered the Season 

and List ID. If it is the first List of 

Germplasm in a season, a dialog will 

appear asking if you want to create a new 

directory, click Yes2. After this a List of 

Germplasm file will open with the name you indicated as List ID. 

Two fields must be filled in the List of 

Germplasm: Entry number and# Tubers/Plot.  

Entry number must be a consecutive list of 

numbers starting with 1, such as 1,2,3,4, you 

cannot leave gaps in numbers such as 1, 2, 5, 

6 or start at a different number 100, 101 etc. 

Use “Fill down” in Excel to generate list. 

# Tubers/plot is  the number of tubers to be 

planted in each plot and must be a positive 

integer number such as 5 or 10.  

Once you have established the List of 

Germplasm click Save as you would any other 

                                                           
2
 If you click No CloneSelector cannot create the Germplasm list and you will get an error. In that case try again. 

Figure 3 Makin a new List of Germplasm 

Figure 5 Example of germplasm list 

Figure 4 List of Germplasm dialog 
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Excel file.  

Note: CloneSelector organizes the lists of germplasm in a separate folder and inside this it creates a 

folder for each season. It is important that you accept the default locations assigned when saving files 

in CloneSelector. If you use Save As and saves a file outside the default structure CloneSelector cannot 

locate the file for example when it is need for generating a fieldbook for your trial. When CloneSelector 

creates a list of germplasm or fieldbook it is automatically stored in the correct folder, and as long as 

you do not change it, it will work fine. 

The List of Germplasm workbook has three sheets: 

 GermplasmList contains a list of the entries to be tested in the experiment and the quantities of 

tubers or seed required for each plot 

 Design is where the experimental design is stored once it has been generated as will be shown 

in the next section 

 SeedLabels contains the labels for the planting material for each plot 
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2.2.1. Open List of Germplasm 

CloneSelector automatically organizes the List of Germplasm in a separate folder for each year which 

helps keeping in order all the files related to a breeding program. You can open the files as normal Excel 

files, but this may implicate some clicking to arrive at the right folder, unless  of course the file is still in 

the list of most recent files used in Excel in which case you just click on it to open it. In order to ensure 

that the file organization of CloneSelector works well it is, however, preferable to use the  Open 

command: 

CloneSelector -> List of Germplas -> Open  

This will open the Open Germplasm List dialog. The drop down 

list for Season will have a list of all the seasons for which you 

have created a list of germplasm. Select the season in which you want to locate the list. After selecting 

the season the List ID drop down will now have a list of all the lists of germplasm generated in that 

season. Select the List ID and click OK to open the List of Germplasm.  

In Excel 2007 you may get a message from the Microsoft Office Excel – Compatability Checker, which is a 

product of the changes made in the 

different versions of Excel.  If this 

message appears you must clear the 

check box for Check compatibility 

when saving this workbook or this 

message will appear all the time. 

Unfortunately in Excel 2007 it is not possible to completely disable the annoying feature. 

 

 

 

 

 

 

 

 

 

Figure 6 Open List of Germplasm menu 

Figure 8 Open List of Germplasm dialog 

Figure 7 Excel 2007 Compatibility Checker problem 
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2.3 Design of field trial with one or more experiments  
 

Next step is to create a design. To do this the List of germplasm 

must be open and if that is not the case, see the previous 

section on how to open it. 

CloneSelector -> List of Germplasm -> Create Design 

Note: Your germplasm list must be open and the GermplasmList 

sheet must be the active sheet, else the Create Design menu is disabled. 

In the dialog Create Design:  

Note: The Create design will 

automatically detect the # entries, and 

you should not change this. If the 

number is incorrect, you may not have 

used a consecutive list of numbers 

starting with 1.  

The design options are divided between 

unreplicated and replicated designs. 

Among the former your may choose No 

randomization, which means the design 

is simply a copy of the list of germplasm 

for each site.  “When some treatments (checks) are replicated r times and other treatments (new 

treatments) are replicated less than r times, an augmented design may be used. These designs may be 

minimum variance designs for estimating contrasts of check effects, of new variety effects, of new 

variety versus checks, or of all check and new varieties simultaneously”. 3 For an Unreplicated design 

designs you must indicate the # of sites or if you have more than one experiment at a site indicate in the 

total number of experiments. The # of sites determines the number of field books that will be generated 

in a subsequent step. 

For Replicated designs you can choose Randomized Complete Block design (RCBD), Completely 

Randomized design (CRD), Incomplete block design4, or Mother-Baby trials5. For RCBD and CRD indicate 

the # of sites and # replications per site. To create a Split plot design you have to use the RCBD and 

create one experiment for each treatment at each site e.g. 3 treatments at 2 sites, you should make the 

design for 6 sites, and once you have made the fieldbooks you can assign the treatments.  

                                                           
3
 On Augmented Designs, W. T. Federer and D. Raghavarao, Biometrics, Vol. 31, No. 1 (Mar., 1975), pp. 29-35, 

Published by: International Biometric Society, http://www.jstor.org/stable/2529707?seq=1 
4
 See for example: https://docs.google.com/viewer?url=http://www.designcomputing.net/pdf/federer.pdf 

5
 See for example: http://www.cazs.bangor.ac.uk/ccstudio/Library/publications/ReviewPapers/mother.pdf 

Figure 9 Create Design menu 

Figure 10 Create Design dialog 

http://www.jstor.org/stable/2529707?seq=1
https://docs.google.com/viewer?url=http://www.designcomputing.net/pdf/federer.pdf
http://www.cazs.bangor.ac.uk/ccstudio/Library/publications/ReviewPapers/mother.pdf
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If you have already created a previous design and want to change it you may use the option Delete the 

existing design. Note if you have not made a design yet, or if you just opened the file this option may not 

be available. In the latter case you may have to create a design twice to be able to delete properly the 

previous version. 

Click OK to generate design. 

A Dialog will appear as if you want to create labels, see below for that option.  

Once the design has been generated 

you must click on the Design tab, and 

verify that the design that was 

generated has the correct number of 

sites, number of reps, etc. You must 

also manually define Blocks if that is 

relevant. It is important to ensure 

that the design is correct before you 

generate field books, as the design in 

the field book is not updated if you 

change it later on. 

In the example you can see how the 

first column in the design indicates the Experiment number, the second column the Replication within 

the experiment, the third indicates the Block (must be entered by user as CloneSelector cannot know 

what blocks are relevant to your field), the forth is the consecutive list of plot numbers, and the fifth is 

the Entry numbers from the list of germplasm, and these will be randomized if that is part of the chosen 

design. 

If you want to use CloneSelector to analyze an existing trial, you must first enter the list of germplasm 

as described above and then generate the design. If the trial was made with a randomized design you 

should copy the original trial design and overwrite the design that was generated. You can for example 

do this by sorting your original design by Experiment, Replication and Plot and then copy the Entry 

numbers into the design or manually enter the Entry numbers. If you do this your fieldbooks will 

subsequently have the same layout as your trial, and it will be much easier to enter the data.  

2.3.1. Make labels for planting material 

 

CloneSelector -> List of Germplasm -> Seed Labels  

In the Labels: Choose Sites dialog, you must choose for which 

sites you want to create labels, typically you want to choose 

Select All.  

Figure 11 Example of design of experiment 

Figure 12 Seed Labels menu 
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Figure 13 Choose Sites for generating labels dialog 

Click OK to define the sites. 

In Make Seed Label select the # of labels in a row on your 

paper. If for example you have labels on an A4 sized sheet 

you may have 3 labels in each row.   

Click OK to generate labels. 

The labels generated may not have the exact size of your 

labels, and you may have to adjust the size. Print a small 

test sample before trying to print all labels, in order to be 

able to adjust the print size to your labels. 

Save the List of Germplasm and Close it.  

  

Figure 14 Layout of seed labels dialog 
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2.4 Generation of a field book for each experiment 
Make sure your List of Germplasm is closed before you start making field books. If this is not the case 

you may get an error as CloneSelector will attempt to open the file again. 

This step will generate one fieldbook in a separate Excel file for each experiment defined in the design of 

the germplasm list. For example if you entered 3 sites in the Create Design dialog, then CloneSelector 

will generate 3 fieldbooks. What happens behind the scene is that CloneSelector takes the information 

from the List of Germplasm and inserts it in all the right places in a fieldbook template. The first time 

you may find the process a bit confusing, but soon you will appreciate the work saved in this step.  

CloneSelector -> Trials -> New  

In New Trial Series Dialog. 

 

Figure 16 New Trial Series dialog 

1. Enter a name for the trial series. Names should not include spaces. The name entered will be 

the name of the Fieldbook files and for each site a number will be added such as for example 

ATYLMZ10B1, ATYLMZ10B2 etc. 

2. Leave Type of Trial as Evaluation Trial (unless of course it is a Mother Baby trial) 

3. In drop down list Select the Season in which you put the Germplasm List, typically this should be 

10B or something similar. 

4. Select the List ID that is the name you assigned to the List of Germplasm. Note: If you have not 

made a Design in the List of Germplasm, you will get a message, in that case click Cancel and 

open List of Germplasm to create design before proceeding. 

Figure 15 New trial menu 
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5. The system will automatically detect the number of Sites in the From Site # to Site #, and if 

that is not correct you have a problem with the design in your List of Germplasm. Cancel and fix 

before proceeding. 

Click OK to start process of fieldbook generation 

Note: If it is a large germplasm list this may take time, 

wait, do not click or close.  

If it is the first Fieldbook in the season Excel will ask if 

you want to create a new directory. Click Yes. If you 

click No the process will be canceled, and you may get 

an error if you Click OK again. In that case close Click 

Cancel in New Trial Series and start again. 

Important in Excel 2007: Excel will open a Dialog 

Compatibility Checker. Make sure to 

Uncheck the box Check Compatibility 

When Saving this book, before clicking 

Continue. If you do not uncheck the 

option you may have to wait for some 

time. Note: The Dialog will appear once 

for each field book, and if you have for 

example 4 sites it will appear 4 times.  

CloneSelector generates automatically 

a new field book for each experiment, 

but they are closed. 

 

 

 

2.4.1. How to open a field book 

To verity the new field books click Trial -> Open.  

 

Select Season and Trial name in the dialog. The files will have the 

Name of the Trial series plus a consecutive 

number.  

Figure 17 Create directory for trials in new season 
dialog 

Figure 18 Excel 2007 Compatibility checker problem 

Figure 19 Trial Open menu 

Figure 20 Open Trial dialog 
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Each Excel workbook has a number of sheets: Fieldbook, Results, and Master are all related to the data 

being recollected on each entry and the analysis of this information. General, Installation, Field, 

Climate_data, and Crop_management are all related to the general information on the setup of the 

experiment. The use of these will be explained in the subsequent steps. 

 

Figure 21 Sheets in a CloneSelector fieldbook 

Open the field books and verify that they are correct. In particular verify the germplasm list and design 

of the trial on the Fieldbook sheet. If you identify a problem you must correct it in the List of Germplasm 

and generate the field books again. 

The field books are stored in C:\CloneSelector\Trial\Season, where the season is for example 10B.  
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2.5 Register metadata for each experiment 
The interpretation of an experiment is not only based on the specific observations, but also on the 

context under which they were observed such as for example where was the experiment undertaken, by 

whom, with what purpose, what was the management, the soil and the weather like? This information 

can be considered metadata i.e. data about data. In CloneSelector you can register a wide range of 

metadata and each Fieldbook has five sheets for documenting the experiment: 

 General with general information on the trial 

 Installation which is the specific setup. You must add the Plot size  

 Field is soil type and previous management 

 Weather data 

 Crop management 

 

Figure 22 Meta data sheets in Fieldbook 

You should not change or delete the standard fields, but if you do not need a field you can leave it blank 

and consider hiding the row. Below the table of standard fields you can add new fields (rows) if needed. 

2.5.1. General information 

This form contains general background information on the trial, and includes information on who 

carried it out, where it was done, and finally it contains the Dublin Core standard information. 

Table 1 General information 

Factor Value 

Trial Name   

Institution 
 Short name or Title: *   

Begin(mm/dd/yyyy): *   

End(mm/dd/yyyy):   

Leader : *   

SubLeader :   

Assistant:   

Creator   

 Country: *   

 Department   

 Province   

 Distritc   

 Locality :   

Crop: *   

 Altitude (masl) *   
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 Latitude *   

 Longitude *   

Type Content:   

Advance%:   

Type of Trial :   

Description: *   

Objetives:   

Comments:   

Year *   

Version   

Contributor   

Owner   

Subject   

Description   

Publisher   

Date   

Type   

Format   

Identifier   

Source   

Language   

Relation   

Rights   

Rightsholder   

License   

Audience   

Provenance   

Embargo till   

Status   

Data   

Project Name and Code:   

 

2.5.2. Installation information 

The installation form contains the information related to establishing the trial in the field. In particular it 

is important to indicate the Density (plants/ha) as this is used in many calculations such as the 

conversion of the yield into t/ha. 

Table 2 Installation information 

Factor Value 
Trial design *   

No. of entries *   

No. of replications *   

No. plants per plot *   

No. rows per plot *   
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No. plants per row    

Plot size (m2)    

Distance between plants (m) *   

Distance between rows (m) *   

Density (plants/ha)   

Date of planting  (Date)   

Date of vine cutting / killing  (Date)   

Date of harvest (Date)   

Measurement date late blight 1   

Measurement date late blight 2   

Measurement date late blight 3   

Measurement date late blight 4   

Measurement date late blight 5   

Measurement date late blight 6   

Measurement date late blight 7   

Measurement date late blight 8   

Measurement date late blight 9   

Measurement date late blight 10   

Measurement date late blight 11   

Measurement date late blight 12   

Interval in days, Late Blight 1 -2    

Interval in days, Late Blight 2 -3   

Interval in days, Late Blight 3 -4   

Interval in days, Late Blight 4 -5   

Interval in days, Late Blight 5 -6   

Interval in days, Late Blight 6 -7   

Interval in days, Late Blight 7 -8   

Interval in days, Late Blight 8 -9   

Interval in days, Late Blight 9 -10   

Interval in days, Late Blight 10 -11   

Interval in days, Late Blight 11 -12   

Late Blight Control cultivar 
 Late Blight control AUDPC observed 
 Late Blight control scale value 
  

2.5.3. Field information 

The field information is related to soil characteristics and prior use of the field. 

Table 3 Field information 

Factor Value 

Predominant Soil Texture  *   

Organic matter (%) *   

Ph. (0 - 14) *   

Crop 1   

Crop 2   
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Crop 3   

 

2.5.4. Weather data 

The weather data contains monthly average data for the weather in the trial period. 

Table 4 Weather data 

Va
lu
es 

Month Avg. 
precip
itacio
n 
(mm) 

Average 
temperatu
re (°C) 

Avg. min. 
temperatur
e (°C) 

Avg. max. 
temperatur
e (°C) 

Avg. 
day/night 
temp. 
fluctuation 

Relative 
humidity 
(%) 

Radiat
ion 
level 

1 Jan-10               

2 Feb-10               

3 Mar-10               

4 Apr-10               

5 May-
10 

              

6 Jun-10               

7 Jul-10               

8 Aug-10               

9 Sep-10               

10 Oct-10               

11 Nov-10               

12 Dec-10               

 

2.5.5. Crop management 

Crop management indicates how the trial was managed. 

Table 5 Crop management 

Intervention 
category 

Intervention 
type 

Date of 
intervention 

Name of 
product * 

Product 
concentration 

Dose of 
application 

Observations 

Fertilizing             

Weed control             

Pest control             

Disease 
control 

            

Irrigation             
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2.6 Field and post harvest data collection in for each entry 

2.6.1. Introduction to potato traits6 

 *Note: While under some circumstances, there are different meanings of the words “variable, trait and 

attribute,” for our purposes we use these words synonymously.+  In experiments, we distinguish 

between classification variables, and response variables which have to be analyzed. Classification 

variables help us to identify plots and how experimental factors and factor levels are applied to plots 

(e.g., year, location, genotype, genotype name, and replication). The classification variables can be 

comparable to our home address by which we can identify who is living where (country, town, street, 

name). Classification variables allow us to identify a plot, its location, which genotype was planted in it, 

and how the plot was treated. Moreover, classification variables are needed to provide statistical 

program packages with information about how the data were organized (e.g. data records are sorted by 

locations, within locations by genotypes and within genotypes by replications) and they are used to 

inform statistical procedures about how to analyze the data records.  In CloneSelector the classification 

variables are mainly entered in the List of Germplasm and automatically transferred when the 

fieldbooks are generated, and the trial metadata are entered as described in the previous section. This 

section is focused on how to collect the response variables data. 

Variables which have to be analyzed can be distinguished:  

(i) Parametric variables: Real numbers following an approximately normal 

distribution (e.g., storage root yield, upper biomass yield, storage root dry 

matter, etc.).  

(ii) Non-parametric variables: Real numbers which show strong deviations from a 

normal distribution (e.g., disease damage).  

(iii) Rank variables (e.g., scores with a scale of 1 to 9 for plant uniformity or scores 

with a scale of 1 to 7 for flowering degree, or scores from 1 to 5 corresponding 

to chipping color).  

It should be noted that the analysis of variance (ANOVA) procedure is relatively robust to deviations 

from the normal distribution, so that even symmetrically distributed rank scores from 1 to 9 can be 

analyzed by an ANOVA. However, the ANOVA is very sensitive to deviations due to variance in 

homogeneity of the error [this is the case when a genotype obtains a common score value across 

replications (e.g., 1 for tuber uniformity = very heterogeneous), while other genotypes obtain different 

scores (e.g. 6 to 9 for tuber uniformity = very uniform)]. No variation among replications results in 

variance in homogeneity, and the requirements of an ANOVA are not fulfilled! Rank variables with 

scores from 1 to 3 should never be analyzed by an ANOVA; however, the frequency means provide 

useful information. Rank variables with scores from 1 to 3 have to be analyzed by rank statistics and for 

these, significance tests and multiple comparison procedures (procedures to compare each clone with a 

check or among all other clones in the trials) are available.     

                                                           
6
 This introduction builds mainly on Chapter 3: Description of Data Collection Forms in Procedures for the 

Evaluation and Analysis of Sweetpotato Trials, Gruneberg et al, 2010. 
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Note: in some places, established breeding programs may have already developed different rating scales 

(e.g. 1 to 5, or 1 to 7 or 1 to 9). It is our hope that all of our partners in this collaborative potato breeding 

effort will be willing to adopt and use the scales given below, so that all may benefit from the power of 

the information provided from comparative analysis of our combined results. 

The following presents the standardized traits recommended for potato7. The traits are grouped 

according to the different stages in an experiment or the method used for measurement: 

 Pre-harvest data 

 Late blight data 

 Harvest data 

 Post harvest data 

In the fieldbook each group of traits have been coded with a color in order to easily be able to identify 

them.  Below is a description of the traits in each group, and how they should be measured or 

assessed. It is very important that all breeders use the same definition of traits and methods of 

measurement in order to be able to analyze data from different breeding programs jointly. 

Initially you should use the fieldbooks without modifications, but after a while you will have identified 

which traits are relevant for your work, and at that point you should modify the trial template in 

accordance with your own needs. This way you will avoid having to add the same information every 

time or hide the same columns. However, in order to know what to modify it is preferable to acquire 

some experience before doing the modifications. 

In the fieldbook you should hide the traits you are not going to measure. Do not delete any columns 

as this may create errors and you may not be able to analyze the data. If you need to measure traits 

that are not in the standard list each group have two or three traits available where breeding programs 

can define additional traits relevant for their local area.  

2.6.1.2 Pre-harvest data 

In the Fieldbook tab the traits with a light green header color are the ones collected before the harvest 

 

Figure 23 Pre-harvest traits 

Plants Planted = number of plants (tubers) planted per plot. 

Plants Emerged = number of plants (tubers) emerged per plot to be determined 3 weeks after planting.   

Plant Uniformity = uniformity of plants per plot to be determined 4 weeks after planting and recorded 

on a scale of 1 to 5 where:  

                                                           
7
  Based on Procedures for standard evaluation trials of advanced potato clones. An International Cooperators’ 

Guide, CIP (2007) 
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1 = very heterogeneous 

3 = heterogeneous 

5 = intermediate 

7 = Uniform  

9 = very uniform 

 

Plant Growth Habit = growth habit of plants in each plot to be determined 30-45 days after planting and 

recorded on a scale of 1 to 6 where:  

1 = erect  

2 = semi-erect 

3 = decumbent  

4 = prostate  

5 = semi-rosette 

6 = rosette 

 

Plant Vigor = Vigor of the plants to be determined 45 days after planting; recorded in scores from 1 to 9, 

where: 

1 = very weak 

3= weak, 5 = medium 

7 = vigorous 

9 = very vigorous 

 

Flowering Degree 0-7 = flowering density to be determined at flowering and recorded in scores from 0 

to 7, where:  

0 = no buds  

1 = bud abortion  

3 = scarce flowering  

5 = moderate flowering  

7 = profuse flowering 

 

Senescence = Plant maturity to be determined before harvest and recorded in scores from 1 to 9, 

where:  

1 = very late 

3 = late 

5 = medium 

7 = early 

9 = very early 
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2.6.1.3 Late Blight Data 

 

  
A maximum of 12 readings of late blight damages should be taken. The percentage of leaf infection is 
recorded throughout the season and the date of each reading is carefully noted. The first reading is 
taken 30 to 40 days after planting and 10 days after the last fungicide application. It is important to 
begin readings as soon as symptoms appear, so the field should be carefully observed to detect the 
initiation of disease. 
 
Percentage of foliage affected by Late Blight 1 – 12 is the percentage of leaf area affected by late blight 

as observed on the date of reading. On the Installation sheet you must enter the date of the reading, in 

Measurement date late blight 1.  

CloneSelector will calculate the intervals between the readings in days, and will use this to calculate the 

AUDPC. 

 

Trait1, Trait2, Trait3…Trait 14 There are 14 columns available to take data on additional traits if 

required.  Indicate the trait being evaluated in rows 23 and 24 on the Fieldbook sheet. Use a 1 to 9 scale 

if making a rating, and provide the description of the trait on the Installation sheet. The user can change 

for example the label Trait1 in row 23 and 24 on the Fieldbook sheet, and also in row 20 and 21 on the 
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Results sheet. There are also 10 notes fields which may be used if desired. Note: For CloneSelector to 

work, no changes should be made in row 1 on any of the sheets as this will most likely cause problems. 

Nor should the order of columns be changed. 

2.6.1.4 Potato harvest data 

The following are the traits to be collected at the potato harvest 

 

 

Figure 24 Harvest traits 

# Plants Harvested = Number of plants harvested. 

# Mark. Tub Cat I = Number of marketable tubers in Category I (tubers measuring > 60mm) 

Mark. Tub Cat I Weight = Weight of marketable tubers in Category I  

# Mark. Tub Cat II = Number of marketable tubers in Category I (tubers measuring 30mm to 60mm) 

Mark. Tub Cat II Weight = Weight of marketable tubers in Category II 

Non-Mark. Tub Num = Number of non-marketable tubers (tubers measuring < 30mm) 

Non-Mark. Tub Weight = Weight of non-marketable tubers  

Tuber Appearance = Appearance of the tubers to be determined on 5 tubers per plot as per the 

requirements in the ICG. 

Tuber size = Size of tubers. Overall assessment of tuber size based on inspection of the harvested tubers 

using a 1 to 9 scale, where:  

1 = very small (< 2cm) 

3 = small (2-4 cm) 

5 = medium (4-6 cm) 

7 = big (6-9 cm) 

9 = very big (> 9cm) 

 

Tuber Uniformity = Uniformity of tubers. Overall assessment of tuber uniformity is based on the 

inspection of the harvested tubers using a 1 to 9 scale, where:  

1 = very heterogeneous 

3 = heterogeneous  

5 = intermediate 
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7 = uniform 

9 = very uniform 

 

Size of stolons = Overall assessment of the length of the stolons based on inspection of the stolons using 

a 1 to 9 scale, where:  

1 = very short (< 8 cm) 

3 = short 

5 = medium 

7 = long 

9 = very long 

 

Selected Clones = Clones selected during the evaluation: 

S = selected  

NS = Not selected 

 

Trait6, Trait7, and Trait8 See note with respect to Trait 1, Trait 2, and Trait 3 above. If the number of 

traits recorded exceeds the 3 available here, additional Trait columns may be used from elsewhere in 

the fieldbook.   

2.6.1.1 Post-harvest data (Dry matter and Specific Gravity)  

 

Figure 25: Dry matter and specific gravity measurements 

F. Weight Tub. Sample 1 = Fresh weight of tubers in sample 1 

F. Weight Tub. Sample 2 = Fresh weight of tubers in sample 2 

D. Weight Tub. Sample 1 = Dry weight of tubers in sample 1 

D. Weight Tub. Sample 2 = Dry weight of tubers in sample 2 

Tub. Weight Air = Weight of tubers in air 

Tub. Weight Water = Weight of tubers in water 

2.6.1.1 Post-harvest data (Oil absorption and French-frying quality)  

The following traits are used to assess the quality of the potato tubers. Note in PTs only the top fraction 

of clones (15 to 25% of all PT clones) needs to be determined, whereas in ATs all clones have to be 

determined. Note also, that an alternative is to use near-infrared reflectance spectroscopy methods to 

assess the quality, and the traits used for this are described under NIRS quality data. 
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Figure 26 French-frying measurements 

Initial Weight Sample 1 = initial weight of tubers in sample 1 

Initial Weight Sample 2 = initial weight of tubers in sample 2 

Final Weight Sample 1 = final weight of tubers in sample 1 

Final Weight Sample 2 = final weight of tubers in sample 2  

External Appearance = External appearance of French-fries assessed using a scale of 4-20, where 4 = 

poor, 8 = fair, 12 = good, 16 = very good, and 20 = excellent 

External Color = External color of French-fries assessed using a scale of 2-10, where 2 = dark, 4 = slightly 

brown, 6 = Golden, 8 = light golden, and 10 = light whitish. 

Internal Color = Internal appearance of French-fries assessed using a scale of 4-20, where 4 = dark grey, 

8 = grayish, 12 = off-white or opaque, 16 = bright white, and 20 = crystalline. 

Texture Outside = External appearance of French-fries assessed using a scale of 4-20, where 4 = soggy, 8 

= moderately soggy, 12 = slightly crispy/soggy, 16 = moderately crispy, and 20 = crispy. 

Texture Inside = External appearance of French-fries assessed using a scale of 6-30, where 6 = very 

soggy, 12 = soggy, 18 = slightly mealy/soggy, 16 = moderately mealy/soggy, and 30 = mealy. 

2.6.1.1 Post-harvetst data (Cooking quality)  

 

Cooking time sample 1 = Time to cooking for the first sample of tubers, assessed according to 

procedures by E. Mihovilovich. 

Cooking time sample 2 = Time to cooking for the second sample of tubers, assessed according to 

procedures by E. Mihovilovich. 

Appearance Whole tuber = Appearance on cooked tubers assessed using a scale of 0-10, where 0 = 

poor, 2.5 = fair, 5 = good, 7.5 = very good, and 10 = excellent. 

Appearance mashed sample = Appearance on the mashed sample of tubers assessed using a scale of 0-

10, where 0 = poor, 2.5 = fair, 5 = good, 7.5 = very good, and 10 = excellent. 
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Texture = Texture of cooked tubers assessed using a scale of 5-40, where 5 = very soggy, 10 = soggy, 15 

= moderately soggy, 22.5 = slightly mealy/soggy, 30 = moderately mealy, 35 = very mealy, and 40 = 

extremely mealy. 

Off-flavor Mashed sample = Off-flavor on mashed sample of cooked tubers assessed using a scale of 0-

20, where 0 = extreme, 5 = much, 10 = moderate, 15 = slight, and 20 = none. 

Sloughing Mashed sample = Sloughing on mashed sample of cooked tubers assessed using a scale of 0-

10, where 0 = extreme, 2.5 = much, 5 = moderate, 7.5 = slight, and 10 = none. 

Discoloration Whole tuber, = Discoloration on cooked whole tubers assessed using a scale of 0-10, 

where 0 = extreme, 2.5 = much, 5 = moderate, 7.5 = slight, and 10 = none. 

2.6.2. Printing the fieldbook sheet 

In order to collect data in the field you can print the Fieldbook sheet, however, before doing so you 

must do some preparations such as adding header information to the fieldbook sheet and hiding the 

traits that will not be scored in this particular experiment. 

2.6.2.1 Adding fieldbook headers 

When working in the field it is necessary to be able to identify well which fieldbook to use for which 

experiment and this can be done automatically if you have filled in the relevant metadata as described 

above. 

The fieldbook header includes the following information: 

 Name of experiment (the same as the name of the file) 

 Site name or location 

 Agroecology 

 Planting date 

 Harvest date 

 Plot size 

 Collaborator 

 Institution 

This information should be added in to the metadata (see above) before inserting the fieldbook header 

CloneSelector -> Trials -> Add Fieldbook header 

After inserting the header you may have to move it or adjust the size of the box or the rows for it to be 

properly positioned. 

2.6.2.2 Hide traits that will not be measured and set print area 

The fieldbook include many traits and you may not measure all of them in the particular trial, and before 

printing you should hide the traits that will not be used. Note: Do not delete columns as this may cause 

problems when trying to analyze the data. 

Figure 27 Add Fieldbook header menu 
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Before Printing fieldbooks 

1. Hide the columns you do not wish to collect. Do not delete columns, only hide. 

2. Define the Print Area as in any Excel sheet 

3. Use Print Preview and Set Print Area as you would in any other Excel sheet. 

Once you have configured the print setup print the fieldbook as any other Excel sheet. 

Note: If you have problems with printing a fieldbook, you may consider copying the relevant headers 

and germplasm list into a temporary Excel file, but do only use this for printing.  

Note: In some cases you may have problems if you try to hide too many columns, and in that case use 

printing via a temporary sheet. 

Save the fieldbook once the printing has been set up correctly. 
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2.7 Enter collected data into electronic field book 
Once data has been collected in the field it must be entered in the fieldbook sheet. The data is entered 

as in any normal Excel sheet. 

When data is entered missing values should be entered as a point or dot i.e. “.”. This is very important 

as Excel in some cases considers an empty cell as cero and this may lead to errors in your data 

analysis. 

2.7.1.1 Checking data quality of the fieldbook data 

CloneSelector include tools to verify that the data are on a valid scale and it will also flag outliers in 

relation to a normal distribution, however, these tools will only detect the obvious errors and it is very 

important that you take precautions to ensure the data is transcribed without errors.  

After data Entry you must check the data quality of the fieldbook. To do this it is useful to have a paper 

copy of the data present so that the problems 

identified can be corrected immediately. 

CloneSelector -> Analysis -> 1. Check Field Data  

A Dialog Correct Errors/Outliers will appear in the 

upper left corner if problems are encountered.  

If you are not able to enter the correct data you must 

enter a point i.e. “.” as a missing value. If you leave 

the cell blank then this may cause problems when calculating the derived values in the Master sheet as 

Excel considers an empty cell as cero, and instead 

of a missing value the calculation may return a 

cero, and you would end up with a difficult to 

detect error in the results sheet.  

In the Correct Errors Dialog the first line indicates 

the type of error or problem for example in this case 

a 10 is an invalid data as the scale is only 1-9, and 

CloneSelector propose to change this to a “.” i.e. a 

missing value.  

The data check is both for false values such as letters in a numeric columns or outliers. The latter is 

values that are more than two standard deviations away from the normal distribution of the other 

values observed. In columns with very homogenous results, this may well flag correct values, and the 

check is only meant for you to ensure that the value is not an entry error. 

In the Dialog you may enter a new value if you discover a mistake, or accept the automatic proposal by 

clicking OK. When clicking Ok the value of the Cell is changed, and it is colored yellow to flag that a 

change was made to the data. 

Figure 28 Check Field Data function 

Figure 29 Dialog to correct data errors 
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The Option Skip, Go to Next will leave the value unchanged, but will color the cell red so that you can 

check it later. 

The check is finished with a Dialog Data Change Completed.  

Check all the cells in red before proceeding with the data analysis. If you subsequently change a data 

value you will have to redo the other steps, so it is important to complete one step fully before moving 

on to the next. 

Save the Fieldbook after data check of field data. 
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2.8 Calculation of derived variables  
Several of the traits observed in the field may need to be converted in order to be more easily 

interpreted or be comparable with results from other trials. For example the yield per plot should be 

converted to yield per hectare.  The following table includes some of the most commonly derived 

variables used in potato breeding. 

Table 6 Calculated fields for potato 

Measurement Calculation 

Percentage plants emerged (Number of plants emerged*100)/(Number of plants Planted) 

AUDPC 1((Yi + Yi+1)/2)*(ti+1 – ti) 

rAUDPC AUDPC Observed/((last reading- first reading)*100) 

Scale(AUDPC) Scale control Genotype * (AUDPC genotype observated/AUPDC control) 

Percentage plants harvested (Number of plants harvested*100)/Number of plants Planted 

Total number of tubers per 
plot 

(Number of marketable tubers category I + Number of marketable 
tubers category II + Number of Non marketable tubers) 

Total tuber weight per plot (Marketable tuber weight category I + Marketable tuber weight 
category II + Non-marketable tuber weight) 

Total tuber yield per plant (Total Tuber Weight/Number plants harvested) 

Total tuber yield (no 
adjusted) 

(Total tuber yield kg plant* Density plant/ha)/1000) 

Total tuber yield adjusted (Total tuber yield kg plant* Density plant/ha)/1000)*(Plants harvest 
percent/100) 

Marketable tuber yield per 
plant 

(Marketable tuber weight category I + Marketable tuber weight 
category II)/Number plants harvested 

Marketable tuber yield per 
ha 

(Marketable Tuber Yield kg plant* Density plant/ha)/1000) 

Total number of tubers per 
plant 

Total Number Tuber/Number plants harvested 

Number of marketable 
tubers per plant 

(Number marketable tubers category I + Number marketable tubers 
category II)/Number plants harvested 

Average weight of a tuber (Total Tuber Weight/Total Number Tuber)*1000 

Percentage dry matter 
content for sample 1 

(Dry weight of tuber sample 1/Fresh weight of tuber sample 1)*100 

Percentage dry matter 
content for sample 2 

(Dry weight of tuber sample 2/Fresh weight of tuber sample 2)*100 

Average percentage dry 
matter 

Average(DryMatterContentSample1Per:DryMatterContentSample2_Per) 

Specific gravity Tuber weight in air/( Tuber weight in air-Tuber weight in water) 

Percentage oil content for 
sample 1 

(Final weight sample 1/initial weight sample1)*100 

Percentage oil content for 
sample 2 

(Final weight sample 2/initial weight sample2)*100 

Average percentage of oil 
content 

Average(OilContentSample1_Per:OilContentSample2_Per) 

Average cooking time (Cooking time of Tuber sample 1 + Cooking time of Tuber sample 2)/2 
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1The formula given for AUDPC in the table above is where t is the time of each reading, y is the percent 

of affected foliage at each reading, and n is the number of readings. The variable t can represent Julian 

days ,days after planting or days after emergence.  

In CloneSelector this conversion or calculation is done in the Master sheet where the first line contains 

the formulas for calculating the variable. You can click at the formulas in the first data row and you will 

see that the formulas are simple Excel formulas that take the data from the Fieldbook sheet and 

calculate the relevant variables.  

2.8.1.1 Calculating variable in CloneSelector 

The variables are calculated almost automatically, however, for the best result you must do some 

preparations: 

1. Finish the Check Fieldbook data quality as described in the previous step and ensure that all 

data is valid or if it is missing a “.” has been inserted. 

2. Make sure that the Density (plants/ha) has been entered on the Installation sheet. This 

value is used in all conversions to hectares. 

3. Note: Do not hide or unhide columns in the Master sheet as this may cause problems when 

running the statistical analysis. 

4. On the Master sheet check in the first second row the formulas that calculate the values. 

Especially the values #Div/0 .  Delete the formula if the problem is that you are not 

collecting the data in this experiment.  

Once you have done the preparations and checked 

the formulas you are ready to do the calculation: 

CloneSelector -> Analysis -> 2. Fill in Master sheet  

This should copy the formulas down to fill in all the 

rows in trial.  

 

Next step is to check the Master data for errors and 

particularly to solve issues with missing data: 

CloneSelector -> Analysis -> 3. Check Master Data  

The two most common error in the Master data are 

generated by  

1. An empty value in the fieldbook is indicated 

as “.” but in the Master sheet it must be an 

empty cell for R to analyze the data 

correctly. 

Figure 30 Fill in Master sheet 

Figure 31 Check Master Data 
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2. If the “.” In Fieldbook is used in a formula in the Master it will generate an error indicated as 

#VALUE!  

In both cases Check Master Data will automatically change the value in the cell to empty and the color 

to yellow to indicate the change. 

A Dialog Correct Errors/Outliers will appear in the 

upper left corner if other problems than the two 

previously mentioned are encountered.  

If you are not able to enter the correct data you 

must leave the cell blank for a missing value. 

RExcel which is used for the analysis will give an 

error if you enter a “.” Or anything else that a blank 

cell for missing values. 

In the Correct Errors Dialog the first line indicates 

the type of error or problem for example in this 

case a missing value that creates a “division by cero error”, and CloneSelector propose to change this to 

a blank cell i.e. a missing value.  

In the Dialog you may enter a new value if you discover a mistake, or accept the automatic proposal by 

clicking OK. When clicking Ok the value of the Cell is changed, and it is colored yellow to flag that a 

change was made to the data. 

The Option Skip, Go to Next will leave the value unchanged, but will color the cell red so that you can 

check it later. 

The check is finished with a Dialog Data Change Completed.  

Check all the cells in red before proceeding with the data analysis. If you subsequently change a data 

value you will have to redo the other steps, so it is important to complete one step fully before moving 

on to the next. 

Save the Fieldbook after the master data has been checked 

2.9 Statistical analysis of trial 
CloneSelector include an option for analyzing a trial in a randomized complete block design with a 

standardized method that generates 2 outputs 

1. A table with the mean value across the replications of each trait for each entry 

2. A table with statistical information for each trait 

a. Mean value of the observations of the trait 

b. Minimum value 

c. Maximum value 
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d. LSD of the genotype 

e. LSD of block 

f. P-value of genotype 

g. P-value of block 

h. Coefficient of variation 

i. Variance estimation for genotypes 

j. Variance estimation for blocks 

k. Residual variance estimation 

The statistical variables can only be calculated if the trait has some variation within, and are not 

calculated for values that are the same in all plots such as for example Number of tubers planted. 

Before doing the Statistical analysis you must Check the Master data as described in the previous step.  

Make sure your data is Saved before attempting the analysis. 

Note: The statistical analysis requires RExcel to be installed, and CloneSelector must have the correct 

Reference to this. RExcel must also be correctly Referenced which is done in the VBA Editor under Tools 

-> Reference, where there should be a reference to RExcelVBALib. This is a different library in Excel 2003 

and 2007. In some cases it may have a reference such as for example Missing RExcelVBALIB 2007 in 

Office 2003, in that case just remove the reference, and make the correct one. If this has not been 

done, you probably need help from an IT person to do this. We will be working on a more user-friendly 

installer, but for now you may need expert help. 

To do the analysis: 

CloneSelector -> Analysis -> 4. Analyze Master Data  

This takes time so WAIT, it may take several 

minutes, depending on the size of your trial and 

your computer. When it is finished it will 

automatically show the Results sheet. 

Note: This step implies sending data to a statistical 

program, and many things can go wrong, so error 

may occur, and it is important to save before 

running the analysis. 

Check that the Result columns are correctly aligned with the labels on the Result table.  The Row just 

above the first Entry has the name of the column in the Master Sheet, and this should correspond to the 

column in the Result table. If they do not coincide you have probably hidden/unhidden columns in the 

Master sheet. To correct it you can either try to revert the Master sheet back to the original state, or 

manually move the content of the result table. We are working on making this more robust.This will be 

the case for the calculation of the AUDPC which is illustrated in section 1.8, page 31 of this manual. 

Figure 32 Analyze master data 
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2.9.1. Analysis of scale(AUDPC) 

The scale(AUDPC) represent a special case in that you need to first calculate the AUDPC in order to 

obtain the observed AUDPC for the reference clone, and then you must enter that value and rerun the 

analysis in order to obtain the scale(AUDPC). If your analysis includes 

the scale (AUDPC) you must perform the following steps after running 

the first analysis. 

Step 1: After the analysis has finished, observe on the Result sheet 

the AUDPC of the reference clone, such as for example 3670.3 for 

PUREN-INIA.  

 

 

 

 

Step 2: Enter the AUPC value of the 

reference clone and the standard 

scale value for it on the Installation 

sheet. 

 

Step 3: Go to Master Sheet and Click Analyze 

Master Data to rerun the analysis with the Scale 

AUDPC.  When the analysis is finished you the 

values will be shown on the Results sheet.  

Note: The analysis is done by sending the data to 

R and it is not like in Excel where you get an 

automatic recalculation. You must click Analyze 

Master Data to get the scale(AUDPC) 

 

 

2.10 Elaboration of consolidated result table for each trial 
After running Analyze Master Data in the previous step the Result sheet should have two tables:  

1. A table with the mean value across the replications of each trait for each entry 

2. A table with statistical information for each trait 

Figure 33 Observe AUDPC of reference 
clone 

Figure 34 Enter observed AUDPC on Installation sheet 

Figure 35 Rerun analysis from Master sheet to obtain 
scale(AUDPC) 



36 
 

a. Mean value of the observations of the trait 

b. Minimum value 

c. Maximum value 

d. LSD of the genotype 

e. LSD of block 

f. P-value of genotype 

g. P-value of block 

h. Coefficient of variation 

i. Variance estimation for genotypes 

j. Variance estimation for blocks 

k. Residual variance estimation 

The final step in the analysis is to check that the Result data are within the range defined for each trait. 

On the Result Sheet, below the Statistical data you will see two rows, Lower and Upper Limit, and in 

these you can define the range that is valid for each trait. In the initial use of CloneSelector you may 

change the values directly in the Result Sheet, but in order not to do this every time you may also 

consider changing it in the Trial Template as described in another section. 

 

Figure 36 Lower and Upper limits for results 

Once you have defined the valid ranges or simply 

accepting the default values, you should check the 

result data: 

CloneSelector -> Analysis -> Check Result Data 

CloneSelector will now apply a yellow color to all 

results that are outside the defined range for the 

trait. It will also check the Min and Max value for 

each trait, so that if you have many entries you only 

have to revise the Min and Max to see if there is a 

problem in a trait. 

That a result is out of bounds may have different 

explanations: 

 It could be a problem with the data on the Fieldbook sheet, but this is not so likely if you 

checked the Fieldbook data and corrected any problem found there. If you find that you have a 

problem on the Fieldbook sheet, you should verify that the Upper and Lower limits are the same 

for the trait on the Fieldbook and Results sheets. If you correct data in the Fieldbook sheet you 

must rerun the whole analytical process, from Check Fieldbook data and all subsequent steps. 

Figure 37 Check result menu 
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 You may also have a problem with formula on the Master sheet, particularly, a problem of the 

data not being converted to the correct scale, and for example your data range may be defined 

considering results in gram, but the actual data has been calculated in kg. In this case you can 

o Change the Upper and Lower limits to reflect the used unit 

o Or change the formula used in the first line on the Master Sheet, and you must then 

rerun the analysis from Calculate derived fields above i.e. initiate with Fill in Master 

Sheet, and then redo the subsequent steps. 

 Or you may find that your Upper or Lower Limits are not correctly defined on Result sheet, in 

which case you should correct them and rerun Check Result data. Or you may accept that in this 

particular case the result is acceptable. 

What is important to understand is that when you change data in the Fieldbook, formulas on the 

Master sheet or limits on the result sheet you must rerun the analytical process from the relevant 

step.  

3. Other functions in CloneSelector 
The previous section of the CloneSelector outlines the uses related to carrying out a trial which is the 

main workflow at this point in time. This section explains some additional functionality which may more 

occasionally be useful such as for example sorting the fieldbook observations or the result sheet. 

3.1 Tools for sorting data and results 
The Fieldbook and result sheets in CloneSelector have quite a complicated structure and if you need to 

sort them according to a certain column you have to be careful not to accidentally mix up your data. To 

avoid problems it is therefore recommend using the sorting tools presented in this section.  

3.1.1. Sorting Fieldbook according to entry number 

Sorting the fieldbook according to entry number will order the fieldbook so that all the plots for one 

entry can be observed easily. To sort by entry the 

Fieldbook must be the active sheet or the menu will 

not be available.  

CloneSelector -> Tools ->Fieldbook -> Sort by Entry  

After this you can observe in the Entry column how 

the fieldbook has been ordered i.e. it starts with all 

the replicates of entry number one, followed by 

entry number two etc. 

3.1.2. Sorting Fieldbook according to plot number 

Sorting the fieldbook according to plot number is the default situation and it will bring the fieldbook 

back to its original order, which means for example the entries will be show the way they were 

randomized. To sort by plot the Fieldbook must be the active sheet or the menu will not be available.  

Figure 38 Sort fieldbook by entry menu 
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CloneSelector -> Tools ->Fieldbook -> Sort by Plot  

After this you can observe in the Plot column how 

the fieldbook has been ordered i.e. it starts with 

plot one, followed by plot two etc. 

 

3.1.3. Sorting Result table according to user selected column 

As part of the analysis of the results it can be useful to sort the Results table according to a column such 

as for example Total Root Yield. To do this the 

Results sheet must be active. 

CloneSelector -> Tools -> Results -> Sort by Column  

After clicking the menu a Sort dialog appears where 

you must enter the column which will determine 

the sort order and you can also chose if it should be 

ascending or descending. Once you have entered 

the information click OK to do the sorting. After 

sorting by yield you can for example easily fill in the 

Yield Rank column. 

The default sort order in results is according to Entry, 

and to return to the original table, you can enter B as 

the Sort by Column and Sort Ascending which will 

then return the results to the original order. 

3.2 Copy existing data set into a CloneSelector Fieldbook 
You may have a trial you already carried out or are in the process of carrying out, and you would like to 

enter the data in CloneSelector, so that you can verify the data and analyze the data. To do this you 

must first create a Fieldbook with the same design as your original design, and subsequently copy over 

the data. 

3.2.1. How to create a CloneSelector Fieldbook based on an existing design 

It is assumed that you already know how to create a germplasm list with a design, and how to generate 

a Fieldbook from this. If that is not the case then consult the relevant sections in chapter 2. The critical 

issue is in Step 3 where you must ensure you use the same randomization as in your original trial, as 

that is the only way to copy over the data with a limited effort.  

Step 1: Generate a Germplasm List and enter the list of germplasm from your original trial (see also 2.2 

Elaboration of list of germplasm to test). Note: CloneSelector requires Entry numbers to be a 

Figure 39 Sort fieldbook by plot menu 

Figure 40 Sort results by column menu 

Figure 41 Sort results dialog 



39 
 

consecutive list of numbers starting with 1, and if that is not the case in your original experiment, you 

must assign new Entry numbers. 

Step 2: Generate a Design of a field trial with the same number of sites and repetitions as you have in 

your historical data for example 2 sites with 3 reps (see 2.3 Design of Field Trial with one or more 

experiments) 

Step 3: From your original trial you must 

enter the randomization of the entries into 

the Entry column on the Design sheet in 

the Germplasm list. This is very important 

as this will help you copy/paste or enter 

your data into the Fieldbook. (see 2.3 

Design of Field Trial with one or more 

experiments) 

If your data is in Excel, you should make 

sure the data is sorted according to Rep 

before you copy the Randomization over. 

After you have modified the 

randomization to match the original trial 

Save the Germplasm list. 

Step 4: Generate the CloneSelector Fieldbooks using the Germplasm list you created in the previous 

steps. Note: It is critical you have entered the original randomization in the Design before you generate 

the fieldbooks. (See 2.4 Generation of a fieldbook for each experiment) 

3.2.2. Enter or copy your existing data into the CloneSelector Fieldbook 

Before you do this you must as described in the previous section Generate a Fieldbook in CloneSelector 

with the same design as your original 

data.  

Step 1: If your data is on paper you will 

have to transcribe them into Excel. If you 

already have the data in Excel you can 

obviously omit this step. 

Step2: Copy your data into the cData 

sheet and insert below each column the 

official abbreviation for each trait. The 

abbreviations are listed on the Fieldbook 

Sheet in the second row. Note the 

abbreviations must be below and not 
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above the columns with data. The order of the columns 

on the cData is not important as long as you have the 

correct abbreviation in each one. When the data is 

copied to the Fieldbook sheet, they will be reordered 

according by matching the abbreviations.  

Step 3: On the Fieldbook or cData sheet select: 

CloneSelector -> Tools -> Copy cData to Fieldbook 

Step 4: Confirm the number of plots by 

clicking OK in the Number of plots 

dialog. If the number of plots in your 

data is not equal to the number of plots 

in your Fieldbook, the automatic import 

may not work.  Though, in some cases 

you may have data with fewer 

repetitions. 

Step 5: Choose the traits to import to the Fieldbook from cData by selecting traits and clicking Select or 

clicking Select All. The trails in the list Traits chosen will be imported. Remember you must put the trait 

abbreviations below the data in each column in the cData sheet. When you have selected the traits you 

want to import click OK.  
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Step 6: On the Fieldbook verify that your data was imported correctly, and Save the work sheet.  

 

3.3 Saving files in CloneSelector 
CloneSelector files are generally just normal Excel spreadsheets and you can save 

and close them as any other spreadsheet. However, CloneSelector also include a 

menu that will save and close the current sheet with just one click.  

CloneSelector -> Save and Close 

The outcome of doing it this way is no different from just using Excel menus. 

CloneSelector automatically stores the Germplasm lists and trials in a folder 

structure order by seasons, and assigning standardized names to the files. This will 

help you organize your work, and at the same time ensure the good functionality of 

CloneSelector, so it is recommend to use the default options with regard to naming 

and storage locations. 

3.4 Convert Fieldbook to CSV 
CSV is an abbreviation for comma separated value file and is a standard format for 

data exchange of information presented in tables. Converting fieldbooks to CSV is 

relevant for using CloneSelector with FieldLog, which is an application for logging trial 

data on a hand held computer, a PocketPC. At this stage the functionality has not 

been tested, however, it is expected that over the next year we will do some testing 

of the use of hand held computers for data logging. More complete information will 

be included in this section once the testing has been done. 

CloneSelector -> 

Convert To CSV 

In practice you 

will want to for 

example convert 

all your fieldbooks 

from one season 

and store them on 

the hand held 

computer and the 

conversion is 

therefore set up 

for bulk 

conversion so that 

you select all the 

Figure 42 Save and 
Close menu. 

Figure 43 Convert 
to CSV menu 

Figure 44 Convert to CSV dialog 
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files you want to convert and it is all done in one operation.  

To select one or more files click on them and then click > to move over to selected or use < to move a 

file back if a mistake was made. 

Once you have selected the files 

to be converted click Convert to 

do the conversion. 

The CSV files will be saved in the 

Trial and season folder with the 

name CSV + current time. Inside 

the folder you will find the 

fieldbooks of all the selected files 

converted to CSV format.  

 

Figure 46 Example of name and location of CSV file. 

  

Figure 45 Dialog advising that CSV conversion has finished. 
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4. Customizing CloneSelector to your needs 
The potato version of CloneSelector is developed in accordance with the established protocol for potato 

breeding and as such it should be generally applicable for most potato breeders, however, you may still 

have to do some modification to work as efficiently as possible. 

1. If you have not placed the CloneSelector folder in the default location directly on the C disk, 

then you will have to adjust the file locations in the options menu as explained below 

2. Once you have acquired some experience with CloneSelector you may decide to modify the trial 

template in order not to have to repeat the same modifications for each trial. This does 

however, require some general understanding of the different elements of CloneSelector and it 

is recommended to carry out a few trials before this is attempted. For the specific instructions 

see below. 

However, before you start out modifying CloneSelector you should understand the basic structure of the 

files and folders used as is described in the following section. 

4.1 CloneSelector file structure 
The CloneSelector folder contains a number of folders and files.  

The Excel file CloneSelector is the file you must open to start CloneSelector. 

Note: with time the CloneSelector file may get corrupted and will not work 

properly. It is therefore recommend that you maintain a backup of 

CloneSelector, and if you experience problems, you can simply copy the backup 

version into the CloneSelector folder. To do so make sure that Excel is closed. 

The fieldbook.R document is an R script used for analyzing the CloneSelector 

data with R. With time we hope to include more analytical options. 

The tpFbk folder is where the templates are stored. Everytime CloneSelector 

generates a new Germplasm List or Trial it is based on a template, and these are stored in tpFbk/Potato. 

The modification of the templates is described below. 

The GermplasmList and Trial folders are for storing user data. A new Germplasm List is sorted in 

GermplasmList/Season and a trial in Trial/Season where Season is folders named for example 10A and 

10B for the two seasons in 2010. CloneSelector automatically stores the information in these folders, 

however, for this to work well the user should adopt naming conventions of both seasons and trial 

series.  

BackupCopy contains a backup of the CloneSelector application and the templates in case any of them 

get corrupted. Should that happen simply copy the relevant files into the original place and restart 

CloneSelector by closing down Excel and reopening CloneSelector. 

Summary is currently not used, but the intention is to be able to generate season summaries in this 

folder. 

Figure 47 ClonseSelector 
file structure 
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4.2 Setting up the location of the CloneSelector files and templates 
CloneSelector aims to help automate and organize certain parts of the trial process. To do this it needs 

to be able to find the templates used for example for generating 

a trial or for storing the fieldbooks. CloneSelector is made to be 

installed by default directly in on the C drive i.e. in 

C:\\CloneSelector. If you install it in another place you will need 

to adjust the File Locations.  

CloneSelector -> Options -> File Locations 

 

This will open the File Locations dialog. To change the 

locations you must click Browse for CloneSelector Folder and 

Browse For tpFbk Folder.  

If you click one of the Browse For buttons that will open the 

Browse for Folder dialog, and you must here locate the 

relevant folder. For CloneSelector folder you must locate a 

folder named CloneSelector and for the templates the folder 

must be named tpFbk or they will not be accepted. When 

you have selected the relevant folder click OK to confirm the 

selection. To close the File Locations dialog and save your 

selection click OK again.  

Figure 48 File Locations menu 

Figure 49 File Locations dialog 
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Note: At this point in time the Language option is not activated and CloneSelector only works in English, 

though it is hoped at a later stage that we will at least also have templates in other languages.  

4.3 Customizing the trial template to your own needs 
The Trial template is what CloneSelector uses to generate fieldbooks for your trials. When you 

customize the template, the changes will be reflected in all the new fieldbooks you generate, but 

existing fieldbooks will be left unchanged. The benefits of changes may include: 

1. You may hide the traits that are not relevant for your work, and that way your future 

fieldbooks will only show what is relevant for you. 

2. You can add meta data such as Country, project leader and other information that is the same 

in all or most trials you generate, so that you only enter it once. 

3. You can use the place holders Trait1, Trait2 etc to insert new traits that are not included as 

standard traits. 

4. You can modify the formula for calculating derived variables e.g. if you want to use plot size 

instead of plant density to calculate yield per hectare, then you will need to change the formula 

in the master sheet. 

4.3.2. Steps to changing the Trial Template 

Changing the template is a delicate procedure and it is 

recommended you make a backup of the template folder before 

you do any modifications. You should also close all open trial files 

or similar to avoid problems. 

Note: You should not delete Rows or Columns in the Trial 

Template, and also be very careful with moving information 

around. If you do this CloneSelector may not work properly, or 

you may have made your data incompatible with other breeders 

data. You should use “Hide” instead of “Delete”, if you do not 

want information to be shown. 

Step 1: Make a backup of the folder 

C:\CloneSelector\tpFbk , which is the folder with all the 

templates. If you have put the CloneSelector in another 

location the route is different, but should include 

CloneSelector\tpFbk. 

Step 2: Select CloneSelector -> Change Templates -> 

Change 

Step 3: Select MSTRIAL as Template to modify and 

Figure 50 Change Template menu 

Figure 51 Select template to modify 
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TRIALENGLISH as Save Template As.  

Note: We hope to be able to work 

with templates in different 

languages, but in this version you 

have to use the English one. 

Step 4: You will be asked if you 

want to overwrite the Master 

formulae. If you click Yes, your 

formulas will be set to the default 

CloneSelector calculations. If you answer No, the formulas will remain unchanged. The latter is useful if 

you have entered your own formulas.  

4.3.2.1 Changing the Fieldbook sheet 

Typical changes to the Fieldbook sheet include: Setting upper and lower limits to control range of valid 

values, modify labels of traits or inserting new traits on placeholders (Trait1, Trait2 etc). 

To modify the Fieldbook sheet click on the tab tpFieldbook. 

 Hide traits that are not measured or observed 

You are unlikely to routinely use all traits in the 

Fieldbook, and you should hide the traits you never 

or rarely use, so that you only see what you need.  

Step 1: Hide all the columns you do not want to use 

in your Fieldbook 

Step 2: Select CloneSelector -> Change Templates -

> Update Default Print Area 

Note: If you have already modified the template 

before you can click Show Default Print Area, and 

this will hide/show all the columns from the 

previous modifications. 

 Modify range of valid observations 

The lower and upper limits of each 

trait in the Fieldbook are defined in 

rows 20 and 21, and to modify the 

range you simply change the existing 

values. If you leave a cell blank, not 

check will be undertaken.  
Figure 52 Setting lower and upper limits in Fieldbook 
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 Insert a new trait to be measured or observed 

To insert a new Trait you simply modify the text in row 23 and 24 where it says Trait1, Trait2,…..Trait14. 

If you want the trait included in the Result sheet either directly or in a calculated form you should also 

change the label on the tpResult, and insert the formula on the tpMaster sheet. For example if we want 

to include a trait: Insect Damage on a scale 

of 1-9 

Step one: On tpFieldbook in row 23 and 

25, modify the Trait2 to Insect Damage and 

in row 20 and 21 set the lower and upper 

limits to 1 and 9 respectively.  

Step two: On tpResults in row 20 and 21, modify Trait 2 to Insect Damage 

Step three: On tpMaster, enter the formula 

for the trait under mTrait2. In our case it is 

simply =tpFieldbook!AI25 , which means the 

value is simply copied over. If you want to 

make more complicated calculations look at 

the other formulas on the Master sheet, and 

you can probably find one that shows you how to do it. Note, if you use a value such as Plant Density or 

Plot size from the Installation sheet, you typically want to make it as a fixed reference (by adding $ in 

front of the row and column reference e.g. $A$1), so that when it is copied down in the Master sheet 

you maintain the correct reference. Again, you may need help from an Excel expert. If you have 

problems with the formula get help from someone with good knowledge of Excel formulas.  

Note: It is important that you insert the formula in exactly the same placeholder trait on the Master and 

the Result sheets, e.g. use mTrait2 and Trait2, as the analysis automatically put the Results in the same 

order as on the Master sheet. But the relation to the Fieldbook sheet is only via the formula on the 

master sheet. You can for example  

 Insert a new trait to be calculated without new observations 

To insert a new calculated trait you simply insert the trait on the tpResult and tpMaster as described in 

step 2 and 3 above. You do not need to insert it on the tpFieldbook unless you also have something to 

observe or measure in each plot. 

4.3.2.2 Changing the Result and Master sheet 

The Result and Master sheets are linked by the analysis, and it is crucial that the order of the columns is 

exactly the same on both sheets, which means if you change something on the Result sheet, you will 

probably also have to change the same column in the Master sheet. 

Step One: On tpResults in row 20 and 21 modify the placeholder e.g. Trait 2 is modified to Insect 

Damage 

Figure 53Modify a placeholder on tpFieldbook e.g. Trait2 

Figure 54 Insert formula in Master sheet 
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Step two: On tpMaster the formula is entered for the trait in the same placeholder, e.g. mTrait2. 

See also above example on modifying Fieldbook for full example. 

4.3.2.3 Changing the General, Installation, Field, Weather_data, and 

Crop_Management sheets 

On these sheets you should enter any variable that does only change infrequently within your breeding 

program. Especially on the General and Installation sheets you may identify variable that are the same in 

all your trials such as: Institution, Leader, and Country. 

If you do not need some of the variables you can hide the rows, but should not delete them. If you need 

to add new variables you can do so below the existing ones.  

4.3.3. Steps to saving changes to trial template 

Once you have done the desired modifications to the 

Trial Template you must save the changes, and to do 

this you must use Update Template Settings. If you 

simply click Save, this will not work.  

The update process involves a serious of steps and 

allows you to do additional changes. In the beginning it 

is probably a bit confusing, but you can simply click OK 

or Yes to go to the next step, and not do any additional 

changes.  

 

 

First you get a reminder that you must 

Click Update Default Print Area if you 

have changed which columns are 

visible. Click Yes, and you can move on.  

 

 

 

 

 

 

Figure 55 Use Update Template Settings to save changes 



49 
 

 

Next dialog is Trial Options. You can here 

change the position of the data on the 

Fieldbook and Results sheets. You should 

NOT make any changes on this form. Click 

OK to move on. 

 

 

 

 

 

 

 

 

In the Trait Limits dialog you can set the Lower and 

Upper values that are acceptable on the Result sheet. You 

can scroll down to see more traits. When you are satisfied 

with the ranges click OK and wait.  

Your trial template is now being updated and it will close 

once the update is finished. Wait until the template 

closes by itself.  

Test the modification of the trial template by creating a 

new trial.  
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5. Installation of CloneSelector 
Note: We hope to be able in the future to provide an automated install for both RExcel and 

CloneSelector, but at the moment it is a bit complicated, especially if you do not have Internet. 

5.1 Installing RExcel 
CloneSelector requires RExcel to be installed, and you cannot run the statistical analysis if that is not the 

case. 

5.1.1. Good Internet or copy of RandFriends and some Internet available: Easiest 

option is using RandFriends  

Note: This is a download of 280 Mb, and may take a long time. 

Note also: The computer must have Internet connection when doing the install or else the install will 

fail. 

Go to: 

http://rcom.univie.ac.at/download.html#RAndFriends 

and click on Download RAndFriendsSetup2122V3.1-13-1-64inc . Note the version number may have 

changed a little. 

Simply follow default installation. 

5.1.2. No Internet: Install R, required components, and RExcel individually, but it is a 

bit complicated 

To do this you must obtain a copy of all the R and RExcel files e.g. on USB stick, CD, or similar. The files 

required are: 

1. R-2.12.2-win.exe  

2. statconnDCOM.latest.exe 

3. rcom_2.2-3.1.zip 

4. rscproxy_1.3-1.zip 

5. RExcelInst.latest.exe 

Note: You may need help from your IT support to do this manual install. 

Note 2: You will need the Administrative privileges to your computer to do this process. Ask your IT 

support. 

5.1.2.1 Step 1 Install R 

1. Unzip R-2.12.2-win.exe.zip 

http://rcom.univie.ac.at/download.html#RAndFriends
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2. Run R-2.12.2-win.exe as Administrator (You right-click on file and choose Run as Administrator) 

 
3.  Accept the default installation options until the Select Destination Location, here you must 

change the location to C:\R . This is important as Windows security will prevent you from 

installing other components if you leave it in Program Files

 
4. Accept the default for the rest of the installation 

5.1.2.2 Step 2: Install rscproxy and rcom 

To do this step you must Run R as Administrator. See step 1 for running as Administrator. Verify that R 

has not been installed inside Program files in step 1 as this may cause problems. 

1. Download from the SweetpotatoKnowledge portal the RExcel.zip file, and unzip this on your 

computer. 
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2. Right-click on the R icon on the desktop and choose Run as Administrator . You will be asked to 

give permission for program to make changes, Click Yes.

 
3. In the R window Click Packages menu, and select the menu Install package(s) from local zip 

files…. 

4. In the Select files dialog navigate to the location where you unzipped RExcel folder, and select 

the zip files rcom_2.2-3.1.zip and rscproxy_1.3-1.zip (use Ctrl+click for the second file).  With 

both files selected Click Open

 
5. In the R Console you should see the messages: Package: ‘rcom’ successfully unpacked…. And 

package ‘rscproxy’ successfully unpacked…. If you get a warning, you are probably not running R 

as administrator or you have installed it in Program Files and windows may have blocked the 

install.  

6. You must now Register the rcom in Windows: to do this enter in the R Console the commands 

and press Enter after each command: 

library(rcom) 

comRegisterServer() 

comRegisterRegistry() 

7. Exit RGui, and Click No when asked to Save workspace image 
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5.1.2.3 Step 3: Install statsconnDCOM 

1. In Windows Explorer double-click on statconnDCOM.latest.exe (you may not see the exe 

extension) 

2. Click Yes to allow to make changes 

3. Accept License agreement 

4. In Select Destination Location make sure to change the Program Files to R i.e. location should 

be C:\R\statconn\DCOM 

5. Accept default installation in next dialogs, and in Ready to install Click Install 

6. You should end up with a dialog Completing the statconnDCOM Setup Wizard, and Click Finish 

5.1.2.4 Step 4: Install RExcel 

1. In Windows Explorer double-click on RExcelInst.latest.exe (you may not see the exe extension) 

2. Click Yes to allow changes 

3. Accept License agreement 

4. In Select Destination Location make sure to change the Program Files to R i.e. location should 

be C:\R\RExcel 

5. Accept default installation in next dialogs, and in Ready to install Click Install 

6. You may now get a dialog about R version, Click OK 

7. You will also get a dialog about Excel being hidden during install, Click OK 

8. And you will get a dialog about multiple users of Excel, Click OK 

9. And you will get a dialog about Help in RExcel, Click OK 

10. You should end up with a dialog Completing the RExcel Setup Wizard, and Click Finish 

5.1.2.5 Step 5: Check RExcel working 

1. Start Excel 

2. Click on Add-Inns (Excel 2007). In Excel 2003 you have a separate RExcel menu 

3. Click RExcel drop down 

4. Click Start R 

5. After a while click RExcel again and you should now see almost all menus active 

You are now ready to run your analysis in CloneSelector 

 

5.2 Installing CloneSelector 
CloneSelector is a collection of Excel sheets and templates, and does not require an install as such, you 

can simply copy it on to your computer. 
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1. Download the CloneSelector.zip, and unzip the folder, you should now have a folder called 

CloneSelector with some archives and subfolders similar to: 

 
2. Copy the CloneSelector folder to C:\, so that the direction of the folder is C:\CloneSelector . You 

may want to put it e.g. on the D drive, or similar, but in that case consult section “Setting up the 

location of CloneSelector files and templates” in this guide.  

3. Double click on CloneSelector.xls inside the folder C:\CloneSelector to open the applications. If 

you get an error message regarding a missing reference se below how to solve it. 

5.2.2. Solving Reference Error problem in Excel 2007 or 2003 

RExcel for Office 2003 is different from RExcel in Office 2007, and this may cause a Reference problem 

when trying to start CloneSelector. The solution is to remove the RExcel 2003 reference and put the 

correct office 2007 or vice versa: 

1. When you receive a message that some library or reference is missing, say Yes to start 

debugger. 

2. You must then stop the debugger by clicking on the Reset square in the toolbar. 

 
 

3. Then click Tools -> References  
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4. Your References on Office 2007 should look like: 

 

 
 

5. RExcelVBAlib is called something else on Office 2003, and you may have to ‘untick’ the RExcel 

reference that is MISSING and tick the correct RExcelVBAlib. Or as the Example below you have 

a missing TAL Barc Code Control, which you should ‘untick’. 
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6. Once done click OK to close Reference dialog 

7. Save CloneSelector in the VBA window

 
8. Close Excel 

9. Open Excel 

10. Open CloneSelector, as indicated in the section “How to start CloneSelector” and now you 

should not get the reference error. 
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6. Annex A: Abbreviations for Potato Fieldbook 
Trait in Fieldbook Abbreviation Trait in Fieldbook Abbreviation 

Plants Planted NOPS F. Weight Tub. Samp 1 FWS1 

Plants Emerged NOPE F. Weight Tub. Samp 2 FWS2 

Plant Uniformity PUNI D. Weight Tub. Samp 1 DWS1 

Plant Growth habit PGH D. Weight Tub. Samp 2 DWS2 

Plant Vigor PVIG Trait 9 T9 

Flowering Degree FLOD Tub. Weight Air TWA 

Senescence SEN Tub. Weight Water TWW 

Trait1 T1 Trait10 T10 

Trait2 T2 Chipping Color CHCO 

Trait3 T3 Trait11 T11 

Late Blight 1 LB1 Initial Weight Sample 1 IWS1 

Late Blight 2 LB2 Initial Weight Sample 2 IWS2 

Late Blight 3 LB3 Finall Weight Sample 1 FWS1 

Late Blight 4 LB4 Finall Weight Sample 2 FWS2 

Late Blight 5 LB5 Trait12 T12 

Late Blight 6 LB6 External  Appearance EXAP 

Late Blight 7 LB7 External  Color EXCO 

Late Blight 8 LB8 Internal Color INCO 

Late Blight 9 LB9 Texture Outside TXOU 

Late Blight 10 LB10 Texture Inside TXIN 

Late Blight 11 LB11 Trait13 T13 

Late Blight 12 LB12 Cook time Sample 1 COT1 

Trait4 T4 Cook time Sample 2 COT2 

Trait5 T5 Appearance Whole tuber APWT 

Plants Harvested PH Appearance Mashed sample APMS 

# Mark. Tub Cat I MTIN Texture TX 

Mark. Tub  Cat I Weight MTIW Off-flavor Mashed sample OFMS 

# Mark. Tub Cat II MTIIN Sloughing Mashed sample SLMS 

Mark. Tub  Cat II Weight MTIIW Discoloration Whole tuber DCWT 

Non-Mark. Tub. Num NMTN Trait 14 T14 

Non-Mark. Tub. Weight NMTW Notes1 N1 

Tuber Appearance TUBA Notes2 N2 

Tuber Uniformity TUBU Notes3 N3 

Tuber Size TUBS Notes4 N4 

Size Stolons STOL Notes5 N5 

Selected Clones SECL Notes6 N6 

Trait6 T6 Notes7 N7 

Trait7 T7 Notes8 N8 

Trait8 T8 Notes9 N9 

   Notes10 N10 

   Other O1 

 

 

 

 


